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Getting Started
In this Chapter

Thank you for using Adaptec® Toast™ 4, the world’s leading CD 
mastering software for the Apple® Macintosh® computer. Toast is 
loaded with powerful features that will make your work easier. To 
get the most out of your new software, please take some time to 
review this document.

➤ System Requirements for Toast 4 1-2

➤ Installing Toast 1-3

➤ Setting Up and Turning On Your CD Recorder 1-4

➤ Creating Your First CD with Toast 1-5

➤ Where to Find What You Want 1-7
1-1
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System Requirements for Toast 4

CPU
� An Apple Macintosh 68040 computer for basic recording of 

data and music.

Memory 
� At least 8 MB of random access memory (RAM) dedicated to 

the Toast application memory. More RAM allocated to Toast 
RAM Cache can help alleviate data transfer irregularities. 

System Software 
� Mac OS 8.1 is the minimum requirement.

� For USB and FireWire, and to take advantage of all the features 
in Balloon Help, Mac OS 8.6 is required. 

Note:  In this document, the term FireWire represents IEEE 
1394, iLink, and FireWire. 

SCSI Recorders
� SCSI Manager 4.3 is recommended. To find out whether your 

Macintosh supports SCSI Manager 4.3, open Toast and notice 
your CD recorder’s identification in the Toast main window. If 
you see “Bus x ID y,” your Macintosh supports SCSI Manager 
4.3; if you see only the SCSI ID (no Bus), it does not. 

Note:  Only the newer PowerBook® computers (2400, 3400, 
and newer) support SCSI Manager 4.3. 
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The Optimal System Configuration
� Power Macintosh

� 2 GB hard drive with at least 800 MB available 

� 128 MB RAM and Virtual Memory turned off

� Mac OS 8.1 through 9.x (OS 8.6 with FireWire 2.2.2 and USB)

Installing Toast 
To install the Toast software application

1 Insert the Toast Installer CD in your CD-ROM drive.

The Toast Installer CD includes installers in several languages, 
each in its own folder. 

2 Locate and open the appropriate language folder.

3 Double-click the Adaptec Toast Installer. 

4 Follow the on-screen instructions to install Toast on your hard 
disk.

About Toast CD Reader Extension
The Toast CD Reader extension is automatically installed in your 
Extensions folder. It allows you to use your CD recorder as a CD 
reader. 
1-3
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Setting Up and Turning On Your CD Recorder
There is no single way to connect a CD recorder to your Macintosh. 
For a successful setup, read and follow the instructions that came 
with your recorder.

For SCSI Devices
� Always turn off your computer and any SCSI devices while 

you connect cables.

� Make sure your recorder is connected securely to the 
Macintosh, using as short a cable as possible.

� If your recorder is a SCSI device, and you have multiple 
devices in a SCSI chain

– Keep the chain as short as possible. Limit the number of 
devices in the chain, and use the shortest cables possible.

– Verify that your SCSI chain is correctly terminated. For 
information on termination, see the device owner’s manual.

– Consider removing all but the recorder from the SCSI chain 
when you are recording. You can avoid problems and 
achieve more satisfying results this way.

Note: SCSI recorders don’t need special extensions to use 
Toast.

For IDE Devices
� For a list of supported IDE (ATAPI) recorders, please see the 

Toast Read Me file. And for the latest version of the list, go to 
this URL, http://www.adaptec.com/cgi-bin/cdrmain.cgi. 

For USB and FireWire Devices
� For a list of supported USB or FireWire recorders, please see 

the Toast Read Me file. For the latest updates, go to this URL, 
http://www.adaptec.com/cgi-bin/cdrmain.cgi. 
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Additional Factors
� While you are recording CDs, if problems occur, disable all but 

essential extensions and control panels. 

– To copy directly from a CD-ROM drive, you need the 
extensions required for that CD-ROM drive. (For example, 
an Apple CD-ROM drive uses Apple CD-ROM and Foreign 
File Access extensions.)

– To copy from a network volume, you need networking 
extensions, such as AppleShare, Open Transport, Network, 
AppleTalk, and TCP/IP. 

Note: Before you use Toast to burn a CD that requires 
copying data from a network volume, please record in 
Simulation Mode. 

Data transfer performance depends on factors not in Toast’s 
control (for example, your LAN or internet traffic at a given 
time of day). It is possible to record from a network volume, 
but not recommended. We prefer that you copy the files to 
your hard disk and record them from there. 

For details on a problem that occurs if data transfer is too 
slow or stalls (common when downloading data from the 
Internet or a local network), see “Buffer Underruns During 
Recording” on page 5-8.

� Allocate most of your unused RAM to the RAM Cache (choose 
Preferences from the Toast Edit menu). 

Creating Your First CD with Toast
With Toast open, the recording process can be as simple as this:

� Select the data you want to write to the CD. 

� Drag the data onto the Toast main window and drop it. (Toast 
usually chooses the best format for you.)

� Click Write CD.
1-5
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How to Make an Audio CD
For purposes of this practice session, choose a couple of songs from 
an audio CD and use them in creating your first CD. At the end of 
this procedure, you’ll be able to play the CD you recorded with 
those songs.

Before you start

� Turn on the recorder

� Make sure Toast is open and the Toast main window is active.

� Insert a clean, blank CD. Use a CD-R, not CD-RW because a 
CD-RW won’t play in a standard CD audio player. Inspect the 
CD for dust or damage. If necessary, wipe the CD in a radial 
motion with a clean, dry, lint-free cloth. 

� Insert an audio CD containing songs you want to copy into 
your CD-ROM drive. Inspect the CD for dust or damage before 
you insert it.

With your preparations complete, begin the procedure.

1 Choose Audio CD from the Format menu.

2 If necessary, double-click the audio CD icon to open it. 

3 Drag a couple of audio files from the audio CD to the Toast 
main window and drop them. (Remember, this is a trial run.) 

4 Click Write CD.

5 In the Start Writing Now dialog box, click Write Disc.

Do not choose Write Session. You can only play the first session 
of a multisession audio CD in a standard audio CD player.

The recorder writes the audio tracks on the blank CD. While 
you wait, a status window shows you how much time is left 
before recording is completed.

6 When you see the message, “Your disc is ready,” click Eject.

If you have a problem, the recorder’s Write Speed may be set too 
high for your CD-ROM drive. For information on using the Check 
Speed feature, see “Using Check Speed to Check the Transfer Rate” 
on page 2-3, or for troubleshooting tips, see “Checking the Data 
1-6
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Where to Find What You Want
Here’s a list of questions about using Toast (and suggestions for 
where to look in this User’s Guide). The questions are grouped 
under these general categories:

� Copying data

� Making an audio CD

� Creating a bootable CD

Copying Data 
� How do I make a data CD to share with friends?

See “Recording with Files & Folders Format” on page 2-7.

� How do I make a copy of my data for backup? 

For simply copying data, see “Recording with Files & Folders 
Format” on page 2-7. Click the Write Session button (instead of 
Write Disc), and you can record on the CD successive times 
until you fill it.

� How do I make a CD for a Windows PC?

See “Recording with Files & Folders Format” on page 2-7. 

� How do I use a CD like a huge floppy disk?

Toast doesn’t mount a CD like a floppy disk, visible as an icon 
on your desktop. If you want to be able to see a recordable CD 
icon and drag items to it and from it, you can use Adaptec’s 
DirectCD™, a software application designed for this purpose.

Making an Audio CD
� How do I copy an audio CD?

See “Recording with Audio CD Format” on page 2-11.

� How do I make a compilation from various audio CDs?

See “Recording with Audio CD Format” on page 2-11. For 
information about using Toast’s Greatest Hits to select audio 
files from different CDs, see “Recording Audio Files Directly 
from Multiple CDs” on page 2-15.
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� How do I copy the audio tracks of an Enhanced CD?

See “Recording with Audio CD Format” on page 2-11. 

For information about extracting audio files, see Chapter 4 
“Toast Audio Extractor.”  

Creating a Bootable CD
� How do I make a bootable CD for my Macintosh?

See “Creating a Bootable CD” on page 2-9.
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Using the Basic CD Formats
In this Chapter

This chapter takes you through the procedures for recording CDs 
using the basic Toast formats. With these formats, you can record a 
wide variety of CDs containing audio and data files. 

For users with more demanding requirements, you may want to 
upgrade to Toast 4 Deluxe. 

➤ Basic CD Formats 2-2

➤ Using Check Speed and Simulation Mode 2-2

➤ Recording with Files & Folders Format 2-7

➤ Creating a Bootable CD 2-9

➤ Recording with Audio CD Format 2-11

➤ Tips for Audio CD Format 2-17

➤ Recording with DISC Copy Format 2-20
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Basic CD Formats
Listed on the Format menu according to frequency of use (most 
used at the top), these are the Toast basic formats:

�  Files & Folders—for recording data that a Macintosh or 
Windows PC can read

� DISC Copy—for recording data directly from a CD-ROM 
player, hard disk, or other block-oriented device connected via 
SCSI, IDE, USB, or FireWire to your Macintosh

� Audio CD—for recording audio tracks in the format used by 
audio CD players

Using Check Speed and Simulation Mode
If you’ve had limited experience working with your CD recorder, 
you may want to use Toast’s Check Speed or Simulation Mode 
features the first time you record a CD in an unfamiliar format. The 
objective of both features is to make sure that the write speed 
defined in Toast for your recorder is not too fast for the speed of 
your source device.

Checking the speed is not always necessary, but there are 
circumstances which make it advisable, at least the first time:

� Audio CD—when the source for music tracks is a CD that may 
be worn or dirty

� Network volume—when the source for files you are copying is 
connected by a network to your Macintosh

Note: Your hardware setup, cables, and the speed or density 
of network traffic may make recording from a network 
volume unacceptable. 

� Removable drive—when the source is on a removable disk

� CD-ROM drive—when the speed of your drive is slower than 
your recorder
2-2
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How Does Transfer Rate Affect Recording?
To write a CD successfully, Toast must be able to get your computer 
to supply a steady stream of data to the recorder. How fast the data 
must be supplied depends on the writing speed and format that 
you’ve selected. As a general rule, your CD-ROM drive must be 
faster than your selected recording speed. For example, if you want 
to record the copy at 2X, your CD reader must be at least a 4X.

The speed of data flow is called the transfer rate; it indicates how 
many kilobytes of data are transferred in one second from the Mac. 

Using Check Speed to Check the Transfer Rate
To see whether your system is fast enough, you can check the 
transfer rate before recording the CD. The procedure varies 
depending on whether you are recording an audio CD or not.

� To check the transfer rate when you are recording non-audio 
files, see “Recording in Files & Folders or DISC Copy Format” 
below.

� To check the transfer rate when you are recording an audio 
CD, see “Recording in Audio Format” on page 2-4.

Recording in Files & Folders or DISC Copy Format

1 Make sure you have gathered in the Toast data window the 
files you plan to copy to a CD.

2 In the Toast main window, click Check Speed.

3 The Check Speed dialog box appears, and the test proceeds as 
follows:

� The Low field reports the lowest number of MB of data per 
second being transferred during the test.

� The High field reports the highest number of MB of data per 
second being transferred during the test.

� The text under those two fields states the minimum 
acceptable speed of transfer required for the recording. 

As long as the number reported as Low is greater than the 
number required for the recording, the speed selected is 
2-3
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4 To re-check, using a different writing speed

a Click Stop.

b Choose a new setting from the Speed menu.

The menu is initially set to match the connected recorder.

c Click Start.

Note: Check Speed is only an approximation (the data is 
read but not transferred to the writer). If the results of the 
test are borderline, try Simulation Mode, which gives a 
more accurate evaluation.

5 As soon as the Write Speed is acceptable, click Done.  

6 In the Toast main window, click Write CD.

The final steps of the process depend on the format you have chosen 
to record the CD. See the specific instructions later in this chapter.

Recording in Audio Format

1 Make sure you have gathered in the Toast data window the 
audio files you plan to copy to a CD.

2 In the Toast main window, click Check Speed.

3 Because you are recording an audio CD, a special dialog box 
appears, listing the tracks you’ve dragged to the Toast main 
window.

� To test a specific track, select it, and then click Test.

� To test the entire list of tracks, click Test All.

4 Another dialog box appears, and the test proceeds as follows:

� The Low field reports the lowest number of MB of data per 
second being transferred during the test.

� The High field reports the highest number of MB of data per 
second being transferred during the test.

� The text under those two fields states the minimum 
acceptable speed of transfer required for the recording. 
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As long as the number reported as Low is greater than the 
number required for the recording, the speed selected is 
acceptable. The speed dialog box disappears, leaving the 
track-test dialog box.

5 In the track-test dialog box, click Cancel.  

Note: Check Speed is only an approximation (the data is 
read but not transferred to the writer). If the results of the 
test are borderline, try Simulation Mode, which gives a 
more accurate evaluation.

6 In the Toast main window, click Write CD.

The final steps of the process depend on the format you have chosen 
to record the CD. See the specific instructions later in this chapter.

What to Do if Check Speed Fails
If you cannot get your equipment setup to pass, try the following 
remedies:

� When a particular audio track shows up with the word Error, 
the CD it came from may be dirty or damaged. For instructions 
on removing problem tracks from the list, see “Removing 
Tracks” on page 2-17.

� When writing data placed on local volumes, turn off all 
network connections.

� For SCSI systems

– Remove all devices from your SCSI chain that are not 
presently needed. Some devices slow down the SCSI bus 
(especially removable-media drives and scanners.)

– Check cables and termination. Defective cables or an 
incorrectly set terminator can slow down the SCSI bus, even 
though the effect may not be noticeable in normal use.

– Turn off all unnecessary system extensions. With Mac OS  
8.1 and later, you can boot with all extensions off by holding 
down the Shift key while starting your Macintosh.
2-5
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� For USB systems

– Except for your keyboard and mouse, make sure there aren’t 
any other USB devices (such as speakers, scanners, or 
printers) on the bus.

– Make sure the keyboard and mouse are on a different USB 
port from the CD recorder.

– Make sure that the USB driver is enabled.

Error Messages

You might get the following error message while checking the 
transfer rate:

“Can’t complete the last command because of a Mac OS error.”

“Result Code = 2” 

This error can occur if you try to use DISC Copy format to copy one 
of the following CDs: 

� CD-i, video CD, photo CD, CD Extra 

� A CD containing more than one track 

� A CD containing more than one session

Toast cannot copy such a CD. 

Using Simulation Mode to Check the Transfer Rate
Simulation Mode lets you run through the entire process of writing 
the CD, exactly like the real writing process, except that the laser is 
not turned on in the recorder, so nothing is written to the CD.

� All error messages that would be displayed while writing can 
also appear in Simulation Mode. For help with some errors, see 
“Error Messages” on page 5-9.

� Simulating the write procedure takes the same amount of time 
as writing.

1 Make sure you have gathered in the Toast data window the 
files you plan to copy to a CD.

2 In the Toast main window, click Write CD.
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3 In the Start Writing Now dialog box, click to activate the 
Simulation Mode checkbox.

*** Simulation Mode*** appears in the menu bar.

4 Click Write Disc or Write Session.

Choose the option you intend to use for the actual recording. 
Write Disc closes the CD at the end of recording. Write Session 
leaves open the possibility that you can record additional 
sessions on this CD later.

Note: During simulation, the write indicator light on the 
recorder turns on, just as if you were actually writing. This 
is normal, and does not indicate that data is really being 
recorded on the CD.

Simulation Mode gives more exact results than Check Speed 
because the data is actually transferred to the recorder. 

Recording with Files & Folders Format
Files & Folders automatically creates a CD that can be read by both 
Macintosh and Microsoft Windows systems. These CDs contain any 
combination of files, folders, and volumes as the source for your 
data. You can even select items from network volumes. (However, 
your hardware setup, cables, and the speed or density of network 
traffic may make recording from a network volume unacceptable.) 

When to Choose Files & Folders Format
� For easy backups

� For data archiving

� To record open files, (for example, the currently used system 
files on your startup volume)

� To determine for each alias you copy whether the alias itself or 
the target file will be written to the CD 
2-7
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Recording a CD in Files & Folders Format
1 Make sure Toast is open and the main window is active.

2 Choose Files & Folders from the Format menu. 

3 In the Toast main window, click Data.

4 Drag the files and folders you want to copy onto the Files & 
Folders window.

Depending on what you drag into the Files & Folders window, 
your results vary.

5 After selecting all your data, click Done. 

The size of the selected data will be displayed in the Toast 
main window.

Note: Toast allows you to save your setup so you can use it 
later. Simply choose the Save As command from the File 
menu.

If you drag… Then…

One folder � Folder icon looks like a CD

� Name of folder = Name of CD

� Contents of folder = Contents of CD

One folder while 
pressing the Shift 
and Control keys 

An “Untitled CD” icon is created, with the 
folder on the top level of the CD hierarchy

Several folders An “Untitled CD” icon is created, with all 
folders on the top level of the CD hierarchy

One or several 
files

An “Untitled CD” icon is created, with all 
files on the top level of the CD hierarchy

Folders and files An “Untitled CD” icon is created, with all 
objects on the top level of the CD hierarchy
2-8
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6 Insert a CD in your recorder. 

This CD may be empty or may contain data that has been 
written as a session. To determine whether the inserted CD is 
still recordable, choose Disc Info from the Recorder menu. 

7 Click Write CD. 

8 In the Start Writing Now dialog box, click an option.

� If you want to add data to this CD later, click Write Session. 
(If your source volume contains more than 625 MB, this 
option is disabled.) 

For the first session, 2 minutes and 32 seconds of a 
74-minute CD are used as overhead, in addition to the data 
recorded. For subsequent sessions, 1 minute and 32 seconds 
are used as overhead for each session. 

� If you want to close the CD so that no further data can be 
added later, click Write Disc.

The writing process begins at the selected speed. When all the 
data is written, Toast automatically verifies the data.

9 When you see the message, “Your disc is ready,” click Eject.

Creating a Bootable CD
1 Make sure Toast is open and the main window is active.

2 Choose Files & Folders from the Format menu.

3 In the Toast main window, click Data.

4 Click the New CD button.

5 Drag the appropriate System Folder into the data window.

Make sure you have the correct System Folder for the 
computer you plan to boot from the CD. Apple places different 
items in the System Folder, according to the specific computer 
where it is used. 
2-9
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Note:  When your computer boots from a CD-ROM, some 
items in a System Folder may not function correctly. Certain 
control panels and extensions must write to a file during the 
loading process, and this cannot happen on a CD-ROM. 
(CD-ROMs are read-only and cannot be modified.) This 
inability to write causes errors during startup. If your 
system won’t boot from a correctly prepared CD, try 
holding down the Shift key during startup. This may 
disable extensions that interfere with the load. Be aware, 
however, that even when you hold down the Shift key 
during startup, some extensions may load and cause the CD 
to be unbootable.

6 Drag additional data you want to copy to the data window.

7 After selecting all your data, click Done.

The size of the selected data will be displayed in the Toast 
main window.

Note:  Toast allows you to save your setup so you can use it 
later. Simply choose the Save As command from the File 
menu. 

8 Insert a CD in your recorder.

This CD must be empty. To determine whether the inserted CD 
contains any data, choose Disc Info from the Recorder menu.

9 Click Write CD.

10 In the Start Writing Now dialog box, click Write Disc.

The writing process begins at the selected speed. When all the 
data is written, Toast automatically verifies the data.

11 When you see the message, “Your disc is ready,” click Eject.
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Recording with Audio CD Format
With Toast you can create two types of audio CD

� A copy of an entire music CD as is

� A compilation of your favorite songs from different audio CDs 
or sound files

There are two ways to accomplish the task. 

� Copy (extract) the audio tracks to your hard disk first, then 
copy them to the CD recorder. 

� Copy tracks directly from the original CD without extracting 
them to your hard disk first. 

Note:  To make a direct copy of an audio track, your 
CD-ROM drive must support audio extraction at a high 
enough rate (1X minimum), and, for SCSI recorders, your 
Macintosh must have SCSI Manager 4.3 installed and 
working. 

Recording an Entire Audio CD
1 Make sure Toast is open, displaying the main window.

2 Inspect the audio CD for dust or damage. If necessary, wipe 
the CD in a radial motion with a clean, dry, lint-free cloth.

Dirt and scratches can impair the ability of the CD-ROM drive 
to read the CD and can slow the data transfer speed. 

3 Insert the audio CD into your CD-ROM drive. 

4 Drag the icon of the audio CD from your desktop to the main 
window of Toast.

Toast chooses Audio CD format for you. 

5 To see the list of tracks, click Audio.
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6 To gain access to the CDDB web site which automatically 
assigns the correct names to the CD and its tracks, make sure 
your modem is connected and turned on. 

� If your setup can dial the Internet automatically, click CDDB 
and let your computer do the rest.

� If you cannot dial the Internet automatically, follow your 
normal procedure for gaining access to the Internet, and 
then click CDDB.

There are a number of ways to configure your Macintosh to 
dial automatically whenever you click a link to the Internet. 
Applications that do this include PPP and Remote Access.

Note: Some albums may not appear in the CDDB library. If 
so, you must type the titles yourself. Also, if you do acquire 
the album title, you should know that it is used by AppleCD 
Audio Player and Toast. It is not used for CD-TEXT.

While in the Audio Track window you can also remove, play, 
rearrange, or rename any of the listed tracks. For details, see 
“Tips for Audio CD Format” on page 2-17. If you want to 
extract the tracks to your hard disk and record from there, see 
“Recording Audio Files from Your Hard Disk” on page 2-13.

7 When you’re satisfied with the Audio Tracks list, click Done.

In the Toast main window, you can see the number of tracks 
and the total time required.

8 In the Toast main window, click Write CD.

9 In the Start Writing Now dialog box, verify the speed is correct 
and click Write Disc.

Recording commences.

10 When you see the message, “Your disc is ready,” click Eject.

You’ve made a copy of an audio CD. You should be able to play it in 
any audio player. (In certain audio CD players, you can encounter a 
problem playing duplicated CDs.)
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Index-Points – Text and Numeric Markers
If you have defined index points in your SoundDesigner II files, 
Toast recognizes them and writes them to the CD. To read the 
markers in your sound files, select the marker type from the Index 
pop-up menu. Choose Text Markers or Numeric Markers depending 
on the type of markers you defined. The number of markers appears 
in the track list. 

Note: Index-points are seldom used, because most audio CD 
players cannot use them (or even see them). 

Not all CD recorders are able to write index-points in Toast’s 
Track-at-Once (TAO) Mode. If your recorder does not support index 
points, a warning message appears when you try to record the CD.

Recording Audio Files from Your Hard Disk
There are advantages to recording an audio CD from files already 
copied to your hard disk. 

� You may avoid some problems caused by damaged CDs. 

� The Macintosh hard disk can handle faster write speeds than 
many CD-ROM drives. 

� You can mix tracks from different albums, creating a 
compilation CD of your favorite songs. (You can also mix 
tracks directly from different CDs. For details, see “Recording 
Audio Files Directly from Multiple CDs” on page 2-15.)

There are two phases to the process. First you extract the files you 
want to copy, and then you record them from your hard disk. The 
procedure below describes simple extraction. If you want more 
control over the extraction process, see Chapter 4, “Toast Audio 
Extractor.” 

Extracting Files

1 Make sure Toast is open and the main window is active.

2 Choose Audio CD from the Format menu.

3 Inspect your audio CDs for dust or damage. If necessary, wipe 
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4 Insert an audio CD into your CD-ROM drive. 

5 Copy the audio CD or selected tracks you want.

� To copy an entire audio CD, drag its icon to the Toast main 
window.

� To copy selected tracks from one or more CDs

a Double-click the CD icon on your desktop.

b From the CD’s directory window, select the tracks you 
want and drag them to the Toast main window.

c Repeat steps 4, 5a, and 5b for each CD that contains 
tracks you want to extract and record.

6 In the Toast main window, click Audio.

The Audio Tracks window shows the list of tracks you selected 
and dragged to Toast. You can remove, play, rename, or 
rearrange any of the listed tracks. For details, see “Tips for 
Audio CD Format” on page 2-17. For information on using 
CDDB to assign names automatically to the CD and its tracks, 
see step 6 on page 2-12.

7 When you’re satisfied with the Audio Tracks list, select all of 
the tracks and click Extract To.

8 In the standard file dialog that appears, specify the destination 
for the files and click Save.

Toast updates the Audio Tracks list to show the AIFF files.

Note: On most systems, extracting audio takes the same 
amount of time as playing the audio. (One minute of audio 
takes one minute to extract.) Each minute of audio requires 
10 MB of disk space. (So 60 minutes of audio requires 600 
MB of disk space.)

9 In the Audio Tracks window, click Done.
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Recording Extracted Audio Files

1 In the Toast main window, click Write CD.

2 In the Start Writing Now dialog box, verify the speed is correct 
and click Write Disc.

Recording commences.

Because audio CDs are single-session recordings, it’s best to 
choose Write Disc, which closes the CD.

3 When you see the message, “Your disc is ready,” click Eject.

Recording Audio Files Directly from Multiple CDs
Toast’s Greatest Hits helps you create a compilation of your favorite 
songs from different CDs or audio files. 

For information on another procedure you can use to create 
compilation CDs, see “Recording Audio Files from Your Hard Disk” 
on page 2-13. Extracting the files first means you can pay less 
attention to the recording process. However, the files may require a 
lot of space on your hard disk. (One minute of audio = about 10 MB 
of hard disk space.)

1 Make sure Toast is open and the main window is active.

2 Choose Audio CD from the Format menu.

3 In the Toast main window, click Audio.

4 Inspect your audio CDs for dust or damage before you insert 
any of them. If necessary, wipe the CDs in a radial motion with 
a clean, dry, lint-free cloth.

5 Insert an audio CD into your CD-ROM drive. 

6 Select the audio tracks you want.

a Double-click the CD icon on your desktop.

b From the CD directory window, select the tracks you want 
and drag them to the Audio Tracks window.

c Repeat steps 5, 6a, and 6b for each CD you want to use.

7 You can remove, play, rename, or rearrange any of the listed 
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Note: To acquire the names of the CD and its tracks 
electronically, use CDDB. Do this before you actually record 
the compilation CD from the named audio tracks. For 
details, see step 6 on page 2-12.

8 When you’re satisfied with the list, click Done.

9 In the Toast main window, click Check Speed.

10 Because you are recording an audio CD, a special dialog box 
appears, listing the tracks you’ve dragged to the Toast main 
window.

� To test a specific track, select it, and then click Test.

� To test the entire list of tracks, click Test All.

11 Another dialog box appears, and the test proceeds as follows:

� The Low field reports the lowest number of MB of data per 
second being transferred during the test.

� The High field reports the highest number of MB of data per 
second being transferred during the test.

� The text under those two fields states the minimum 
acceptable speed of transfer required for the recording. 

If the word Error shows up beside one or more tracks in the 
list, there are different possible causes and solutions. 

� If Error appears beside all the tracks, it is probable that the 
system cannot handle the selected write speed. Choose a 
lower speed and test the tracks again.

� If Error appears beside a particular track (or scattered tracks 
on the list), the source audio CD may be dirty or damaged. 
The simple solution is to remove the track. For instructions 
on removing a problem track from the list, see “Removing 
Tracks” on page 2-17. 

12 As soon as your assembled tracks pass the speed test, click 
Cancel. 

13 In the Toast main window, click Write CD.
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14 In the Start Writing Now dialog box, verify the speed is correct 
and click Write Disc.

During the recording process, Toast prompts you to insert 
different CDs at the appropriate times.

15 When you see the message, “Your disc is ready,” click Eject.

Tips for Audio CD Format
Like all great Macintosh applications, Toast offers more than one 
way to accomplish most tasks. These tips point out some of the 
alternatives.

Selecting Tracks
1 Select the audio files in the Finder and drag them onto the 

Audio Tracks window. 

2 When selecting from an audio CD, drag one or more tracks, or 
to select all the tracks, simply drag the icon of the CD.

Rearranging Audio Files
To change the order of tracks on the finished CD, drag individual 
audio files around in the Audio Tracks window.

Removing Tracks
To remove tracks from the list, select the files and click Remove.

Note: Removing items from the list cannot be undone. 
However, if you remove something from the list by mistake, 
you can re-import the file.

!
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Previewing Tracks
To play a track, select it in the Audio Tracks window and click Play. 
The track plays back using the Macintosh internal audio output. If 
the track is on a CD that’s not currently mounted, Toast prompts 
you to insert it.

Note: Playing audio tracks requires the system extension 
Sound Manager.

Saving Tracks as Sound Files (Audio Extraction)
Toast can save an audio track as a standard AIFF sound file. Simply 
select the desired track or tracks in the Audio Tracks list and click 
Extract To. For a detailed procedure, see “Recording Audio Files 
from Your Hard Disk” on page 2-13.

Entering and Editing the Names of Source CDs and Tracks
When you drop an audio CD onto the Toast main window, a small 
dialog box asks you to give the CD a more descriptive title. 

You can type the title yourself and click OK, or you can click CDDB. 
If you click CDDB, and the CD is present in the CDDB online library, 
CDDB assigns the album title and all the track titles automatically 
for you.

You can edit these names in the Toast Audio Tracks window. There 
are two ways to do this

� Double-click a CD icon in the track list to display the naming 
dialog box. Then enter the CD title and track name(s), and click 
OK. To move to a different track, use the small arrows in the 
lower left corner of the dialog box. 

� Select the track name in the Audio Tracks window. Wait about 
1 second, and the highlight color changes, indicating that you 
can now type a new name. (This in-line editing procedure 
works the same as renaming an icon in the Finder.) Another 
way to activate in-line editing is to Command-click the line 
you want to edit. When you have selected and edited one line, 
you can use the Tab key to move to the next line.
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Note: If the AppleCD Audio Player happens to be open on 
the desktop at the same time you enter a new name for a 
track, you’ll see an error message. Close the AppleCD 
Audio Player, and the problem disappears.

You can also edit the names using the AppleCD Audio Player. 

1 Choose the player from your Apple menu.

2 Type the CD and track names in the appropriate fields.

Writing from Multiple Source CDs
If you have selected tracks from more than one CD, Toast displays a 
list of the CDs when you click Write CD.

Make sure you have all the source CDs available before proceeding, 
because the write process cannot be stopped once begun. 

While Toast is writing, the Greatest Hits dialog box prompts you to 
insert the appropriate source CD as it reads each track.

The Pause Between Tracks
Toast automatically inserts a two-second gap between tracks. To 
specify a different gap

1 Select the track(s) for which you want to change the pause.

The menu sets the pause before the selected track(s).

2 Click Pause at the top of the list or click a selected track.

3 Choose the pause you want from the pop-up menu that 
appears.

Note: The pause before the first track cannot be fewer than 
two seconds.

If your recorder does not support pauses smaller than two seconds, 
you may see this message:

“The currently selected recorder has a fixed pause of 2 seconds 
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Recording with DISC Copy Format
DISC Copy lets you record directly to a CD from block-oriented 
devices connected to your Macintosh via SCSI, IDE, USB, or 
FireWire. DISC Copy creates the exact copy of such devices as

� CD-ROM drive with a single-session CD inserted

� Hard disk

� Magneto-optical drive

� Removable drive with a disk inserted 

When to Choose DISC Copy Format
� To copy a bootable CD

� To copy a hybrid CD (for example, Macintosh and Windows)

� For easy backups

When to Choose a Different Format
� For reproducing a readable copy of a Macintosh computer 

hard disk, use Files & Folders format (see page 2-7). 

� Because DISC Copy makes an exact copy of a volume, the 
resulting CD may not work as expected. For example, if you 
copy a volume formatted as a DOS drive, it won’t work 
properly on a Windows PC; Windows PCs require the ISO 
format for CDs, but your CD would have the format and 
structure of a hard disk. 

� If you have a bootable CD that can’t boot newer Macintosh 
computers and want to make a copy that can, use Files & 
Folders format and make the CD bootable to update the driver 
on the copy you create. (For details, see page 2-9.)

Special Requirements
You must observe the following restrictions: 

� You cannot copy CDs that contain mode2 form2 sectors, for 
example, video CDs, CD-i, photo CDs, etc., because the 
Macintosh computer cannot read those sectors. 
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Recording a CD in DISC Copy Format
1 Choose DISC Copy from the Format menu.

2 In the Toast main window, click Data. 

All connected valid source devices are displayed.

3 Select the device to be copied and click OK. 

A dialog box appears, showing the capacity of the device and 
its contents in MB, block size, and number of blocks. (When 
you select a CD that you have written yourself, Toast 
automatically subtracts the unreadable blocks at the end of the 
CD to avoid errors while writing.)

It is best not to change the numbers in the dialog box. Doing so 
may cause your CD not to work. However, if you need to copy 
the contents of a large hard disk (e.g., 1 GB) to a CD, you must 
make a couple of adjustments. 

a In the dialog box, change the Copy pop-up menu from 
Blocks to Megabytes.

b Defragment your large hard disk. (This puts all the data at 
the beginning of the disk.)

c In the Copy field, type a number that equals the amount of 
data on your hard disk + an additional 50 MB. 

For example, on a 1 GB hard disk, with 650 MB “available,” 
you have roughly 350 MB of data, and 350 + 50 = 400 MB. So 
you should type 400 in the Copy field. When you record the 
contents, Toast copies the defragmented 350 MB plus a bit of 
extra space for comfort.

4 Click OK.

The Toast main window displays the amount of data to be 
written.

5 Insert a blank CD in your recorder. 

To verify that the inserted CD is indeed empty, choose Disc 
Info from the Recorder menu. 

6 Click Write CD.
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7 In the Start Writing Now dialog box, choose an option.

� If you want to add data to this CD later, click Write Session 
(not recommended). 

� To close the CD so that no further data can be added later, 
click Write Disc.

The writing process begins at the selected speed. 

8 When you see the message, “Your disc is ready,” click Eject.
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File Menu

Open
Opens previously saved Toast files (or virtual images). Open 
restores all the settings and file selections to the same state as when 
the file was saved most recently.

Save / Save As
Saves a virtual image containing references to all selected data, 
settings, and modified file names so they can be restored later.

Virtual images can be created for every format. 

When you quit Toast or switch to a different format, Toast asks if 
you want to save your current settings.

Note:  A virtual image saves references to selected files, but 
not the files themselves. If you delete the original data, the 
image becomes invalid. 

Revert
Reverts to the last-saved Toast document (virtual image).

Quit
Exits the Toast application, after asking you to save your settings 
(when appropriate).

Note: Clicking the Close box in the main window is the 
same as choosing Quit.
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Edit Menu

Standard Commands
Undo, Cut, Copy, Paste, Clear, and Select All are standard Macintosh 
commands that are available for use in any of Toast’s lists or error 
logs.

You can use the Copy command to copy as text all selected items in 
the Toast data window for Files & Folders format.

Preferences
Displays a dialog box that lets you set specific operational 
parameters for Toast.

Disk Cache

Sets aside space on your hard disk for Toast to store small files 
temporarily while optimizing and writing on-the-fly. 

If you have more than one hard disk attached to your Macintosh 
computer, you can choose from the pop-up menu which drive to use 
for this temporary storage. Choose a fast drive that has sufficient 
free space. 

Note: Do not select an optical drive or other slow storage 
device for the Disk Cache.

RAM Cache

Augments the RAM cache built into your recorder with RAM 
installed in your Macintosh computer. The amount of RAM Toast 
uses for cache enhancement is selectable from the pop-up menu.

You can choose a relative amount, based on the selected write speed, 
or you can set a specific amount of RAM to be used, regardless of the 
write speed.

In general, if you are writing CDs from data sources with erratic 
data rates (such as network volumes), you should set a higher value 
for the RAM Cache. On the other hand, if you generally write from a 
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Preferred Drive for Reading Audio 

If you have more than one CD-ROM drive on your system, you can 
use this menu to specify which drive ejects when Toast requests an 
audio CD. 

To verify that the selected drive has audio extraction capabilities, 
insert an audio CD into the drive and click Test. 

Calculate a Checksum While Verifying 

When this option is checked, Toast calculates a checksum each time 
it verifies a CD. This is useful if you are writing CDs from image 
files created in another application that also calculates a checksum 
(such as Astarte CD-Copy). You could then compare the two values 
to ensure that the CD is identical to its source.

Once the checksum is calculated, you can choose Copy from the Edit 
menu to copy it to the clipboard.

Note: if you do not have software that generates images and 
checksums, do not check this option.

Look and Feel

Changes the appearance of Toast’s windows. Choose an item from 
the pop-up Look and Feel menu. To see the change, you must quit 
and reopen Toast.

PowerKey/Rebound Compatible

Tells Toast to send “don’t restart” commands to PowerKey or 
Rebound. When writing a CD, Toast locks out other applications to 
ensure that the flow of data to the recorder is uninterrupted. Having 
the PowerKey/Rebound Compatible option active prevents restarts 
in the middle of recording a CD. (PowerKey and Rebound send a 
Restart command to your Macintosh unless they are told not to at 
regular intervals.) 
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Format Menu
Use the Format menu to select the specific CD format that you want 
to write. 

For information about each format, see the pages listed below:

�  Files & Folders—See “Recording with Files & Folders 
Format” on page 2-7.

� Audio CD—See “Recording with Audio CD Format” on 
page 2-11. 

For specific information on using Toast’s Greatest Hits, see 
“Recording Audio Files Directly from Multiple CDs” on 
page 2-15.

� DISC Copy—See “Recording with DISC Copy Format” on 
page 2-20.

Recorder Menu

Write Speed
Specifies the speed you want the recorder to use when writing a CD. 
Only the speeds applicable to your recorder are available in the 
menu. (The speeds not supported by your recorder are dimmed.)

Note: If you prefer, you can also set the write speed in the 
Start Writing Now dialog box.

Simulation Mode
Lets you simulate the process of recording data or music on a CD for 
purposes of validating write speed and other factors that influence 
recording. 

If you are recording files from the Internet or a LAN, the flow of data 
is often inconsistent. Simulation gives you a chance to determine 
whether it’s possible to make a successful recording from the net. 
However, even a successful simulation doesn’t guarantee a good 
recording. Network conditions are too unpredictable. 
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If you are recording directly from an audio CD in your CD-ROM 
drive, simulation lets you know whether tracks on the CD can be 
recorded successfully at the speed you select.

Disc Info
To view information about the CD-R currently inserted in the 
recorder, choose this command. Available information includes:

� Media type (recordable or not)

� Sessions already on the CD

� Used and available CD space 

� The number of megabytes/blocks available (which can be 
used for additional sessions on the CD)

If your recorder has CD-RW capability and a CD-RW inserted, the 
Disc Info window includes an Erase function. To erase a CD-RW, 
click Erase.

In the dialog box that appears click Quick Erase or Erase. If you click 
Quick Erase, the process takes approximately 10 minutes. If you 
click Erase, the process takes up to 80 minutes. If you intend to use 
the CD-RW with Adaptec’s Direct CD product, click Erase. 

Recorder Info
Displays technical information about the connected CD recorder:

� Recorder model

� Firmware version

� Cache size

In addition, there is a Self Test button. 

Note: Self Test may give inaccurate information, depending 
on how your recorder’s firmware handles the command 

Eject
Ejects any currently inserted CD from the recorder.
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Mount CD-ROM (from the Recorder)
Causes any mountable sessions on the currently inserted CD to 
appear on the Macintosh computer desktop. Once a CD is mounted, 
it can be used normally until you eject the CD or restart the 
computer, even if you exit the Toast application.

Utilities Menu

Compare
Compares the contents of two data sets to see if they match. You can 
compare two volumes, two folders, or two files.

Note: Compare differs from the verification that Toast 
performs after writing a CD. First, verification always 
compares the selected source data to the finished CD; with 
Compare, you compare any two data sets. Second, Compare 
checks each individual file when comparing the data; 
verification compares only blocks. The Compare command 
usually tells you exactly which file contains the error.

To compare volumes, folders, or files, perform the following:

1 Choose Volumes, Folders, or Files from the pop-up menu.

2 Select the desired original and copy.

3 Click Compare.

Toast displays a list of any mismatches.

To create a text-clip file, select items from the list and drag 
them to the desktop. To open the clip, double-click its icon.
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Check Aliases
Examines all the aliases on a specified volume to ensure they point 
to items on the same volume and that all the original files can be 
found. Always check aliases before writing in Files & Folders 
format.

In the dialog box that appears, select the volume you want and click 
OK. Toast checks the aliases and displays any problems in a list. Be 
sure to delete or correct any nonfunctional aliases before recording 
your CD.

Internet Menu

Web Checkup
Looks for Toast upgrades on the Internet.

Adaptec CD-R Home
Provides a submenu you can use for easy Internet access to helpful 
resources.

Deluxe Info
Provides information on the Deluxe version of Toast.

CDDB Website
When you copy an audio CD for recording in Toast, you can take 
advantage of the CDDB web site to acquire names for the CD and its 
tracks. All you need is a modem and a connection to the Internet. 
For details, see step 6 on page 2-12.

Help Menu
Toast provides contextual information with Balloon Help. To turn on 
Balloon Help, choose Show Balloons. To turn it off, choose Hide 
Balloons.
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Recording a CD in HFS+ Format
Most of the time Toast generates the file system for use on a CD it 
records. For Macintosh use, the file system is HFS. Toast never 
generates HFS+ on its own.

In the Deluxe version of Toast, it is possible to create a CD in HFS+ 
format. 

Copying an HFS+ Volume (Mac OS Extended Format)
If a volume you are recording to CD is formatted in HFS+ and you 
want to retain that format, use the DISC Copy format.

Track-At-Once (TAO) Recording
The TAO Mode records each track of a CD individually with 150 
empty sectors immediately preceding it and 2 run-out sectors at the 
end of each track.

With some recorders, it is possible to change the number of empty 
(silent) sectors preceding audio tracks, also known as the pause, 
usually 2 seconds (150 sectors). The pause before the first track, 
however, cannot be fewer than 2 seconds.

ISO Names on a Macintosh
The ISO naming convention lets you retain file names that don’t 
observe the DOS 8.3 filename/extension rule. When you choose the 
Files & Folders format, Toast creates both Macintosh and Microsoft 
Windows CDs automatically.
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About CDs
A CD (compact disc) is 1.2 mm thick and has a diameter of 8 or 12 
cm. Its data capacity is approximately 550 MB for 63-minute CDs, 
650 MB for 74-minutes CDs, and 700 MB for 80-minutes CDs. The 
exact capacity varies from one brand of media to another.

The access time and data-transfer rate of a CD is typically much 
slower than a hard disk, although technological improvements have 
resulted in CD-ROM readers that read significantly faster than the 
original single-speed drives. 

The recordable part of a CD consists of (at least) three blocks:

� Lead-In block—Holds the directory information; located on 
the innermost 4 mm of the CD’s recording surface.

� Program block—Holds the data or audio tracks and fills the 
next 33 mm of the CD.

� Lead-Out block—Marks the end of the CD and fills the 
external 1 mm.

A CD is divided into sectors. The actual available size for data is 
2352 bytes for each sector. 

Different CD formats use that 2352 bytes in different ways. For 
example, an audio CD uses all 2352 bytes for audio data, while data 
formats need several bytes for error detection and correction.

Each sector of a CD is again divided into logical blocks of 512, 1024, 
or 2048 bytes. The block sizes are part of the definition for each CD 
format. 
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There are five different types of sectors:

Type 1: Red-Book Sector or Audio Sector

Type 2: Yellow-Book Data Sector Mode1

Type 3: Yellow-Book Data Sector Mode2

Type 4: CD-ROM XA and Green-Book Data Sector Mode2-Form1

Type 5: CD-ROM XA and Green-Book Data Sector Mode2-Form2

� Type 1 sectors are audio sectors; they contain only audio 
samples (1 Sample = 4 bytes).

� Types 2 and 4 are data sectors used to store computer data.

� Type 5 is a data sector used to store compressed audio and 
video data. 

� Type 3 is rarely used.
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 Header 
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      Error Correction
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             Data
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   EC 
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        8
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Standard recordable CDs (12 cm diameter) can hold 63, 74, or 80 
minutes of data. Because CDs were originally conceived to store 
only audio data, their capacity is measured in time rather than 
megabytes. 

minutes:seconds:frames – 1 frame = 1 sector 

The data for audio CDs is 16 bit/44.1 KHz, stereo. That is, each 
audio sample occupies 4 bytes (16 bits = 2 bytes per channel), and 
1 second of audio contains 44,100 samples. 

Because an audio sector (type 1; 2352 bytes/sector) contains only 
audio samples: 2352/4 = 588 samples/sector. One second contains 
75 sectors: 44.100/588 = 75 sectors/second. Therefore a 74 minutes 
CD-R contains 333,000 sectors (4,440 * 75).

The number of megabytes a CD can hold depends on the type of 
sectors used on the CD:

� If only type 1 sectors are used, these 333,000 sectors correspond 
to approximately 747 MB of audio data (333,000 * 2352 bytes).

� If types 2 or 4 are used, they correspond to approximately 650 
MB of data (333,000 * 2048 bytes).

If a CD is read with a standard, single speed CD-ROM drive, 150 
kilobytes of data are read per second (75 sectors * 2048 bytes in 
1 second). 
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Toast Audio Extractor
In this Chapter

The Toast Audio Extractor is an application that lets you save tracks 
from an audio CD as Macintosh computer sound files in a variety of 
formats. It requires a CD-ROM drive that supports audio extraction.

Getting Started
To launch Toast Audio Extractor, double-click its icon in the Finder.

After a moment, the main window appears. If an audio CD is 
already mounted, its contents are shown in the window; if not, 
insert one to begin.

➤ Getting Started 4-1

➤ The Main Window 4-2

➤ Operational Controls 4-3

➤ Zoom Controls 4-4

➤ Extracting Tracks 4-4
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The Main Window
You can control all of the application’s functions from this window.

Track List
The track list shows the number, title (if available), and length of all 
the tracks on the CD. If you have previously named the tracks using 
AppleCD Audio Player, the names are taken from the AppleCD 
Audio Player’s database and are displayed in the track list. 

Naming the CD and Its Tracks
1 To edit the names with Toast Audio Extractor, double-click any 

item in the track list.

The naming dialog box appears 

2 Enter the desired CD and track name(s) then click OK. 

You can use the arrows to move to a different track. The names 
are stored in the Apple CD database, available to applications 
that use that data (Toast, Toast Audio Extractor, and AppleCD 
Audio Player, among others). This is not CD TEXT.

The Track Display
The Track Display area shows a graphic representation of each track 
on the CD. Initially, each track is indicated by an open rectangle.

To view the waveform of one or more tracks

1 Select them in the track list or track display.

2 Click Preview. 

The progress window appears while Toast Audio Extractor 
reads the tracks and builds the waveforms. This may take a 
while, depending on the length of the tracks and the speed of 
your CD-ROM drive.
4-2



 

Toast Audio Extractor

About the Overlap Option
Toast Audio Extractor attempts to preview and extract audio data at 
the full speed of your CD-ROM drive. On some drives, this may 
result in errors that reveal themselves as clicks when you listen to 
the sound files.

If you experience this problem, activate the Overlap (safer but 
slower) check box in the extraction Progress window. When Overlap 
is checked, Toast Audio Extractor verifies the data before saving it, 
to ensure accurate extraction.

After reading, Toast Audio Extractor displays the waveforms.

Note: Toast Audio Extractor stores the data for the 
waveform display in a folder called TAE Waveform Cache ƒ, 
located in the same folder as the Toast Audio Extractor 
application. If you delete these files, the waveforms must be 
recreated the next time you use that particular CD.

Operational Controls
The upper right-hand section of the main window contains the main 
controls. There are buttons for starting the extraction process, setting 
sound options, and playing and previewing the selected audio 
tracks. 

Options
If you click Options, the Sound Format dialog box appears. Use it to 
specify the format you want for the extracted tracks.

The selected format is also indicated in the lower right corner of the 
main window.

Extract
To begin extraction of any selected tracks, click Extract. If no tracks 
are selected, the entire CD is extracted.
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Zoom Controls
The Toast Audio Extractor main window contains the Zoom 
controls. They affect what you see in the Track Display area.

The Zoom controls appear as four small buttons on the right side of 
the main window, just above the track display area.

� Zoom In (magnifying glass with a + sign)—Increases the 
magnification of the selected track(s).

� Zoom Out (magnifying glass with a – sign)—Decreases the 
magnification of the selected track(s).

� Show All (miniature wave form)—Shows all the tracks in the 
Track Display area.

� Zoom to Selection (small CD icon)—Zooms the selected 
track(s) to the full width of the Track Display area. This is 
useful if you want to select just a portion of a track for 
extraction.

Extracting Tracks
To extract tracks from the CD

1 Select the desired track or tracks and click Extract. Toast Audio 
Extractor presents a standard file naming window. 

2 Specify the name and location for the extracted files and click 
Save.

Note: As a short-cut, you can select any track or tracks in the 
track list or track display and drag them to the desired 
location in the Finder. Toast Audio Extractor immediately 
begins extracting the chosen items to that location.
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Troubleshooting
In this Chapter

This chapter provides solutions to problems you may encounter 
while recording CDs or viewing the CDs you have recorded. 

Problems with the Basic Formats 
Listed on the Format menu according to frequency of use (most 
used at the top), these are the Toast basic formats:

� Files & Folders

� Audio CD

� DISC Copy

➤ Problems with the Basic Formats 5-1
Files & Folders Format 5-2
Audio CD Format 5-3
DISC Copy Format 5-5

➤ General Problems 5-5

➤ Error Messages 5-9
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 Files & Folders Format
 Files & Folders is one of the basic formats. For more information 
about its use, see “Recording with Files & Folders Format” on 
page 2-7.

Toast reports that some aliases couldn’t be resolved
Resolve Aliases is checked (activated), and aliases in the data you 
are copying point to files Toast can’t find. This often happens, for 
example, when you drag a System Folder to Toast containing aliases 
of recently used applications. 

Deactivate Resolve Aliases, and Toast records the aliases as aliases 
(unresolved), displaying them in italics.

Toast cannot find the related volume (error code = –35)
Resolve Aliases is checked (activated), and aliases in the data you 
are copying point to a volume Toast can’t find. 

Mount the missing volume or deactivate Resolve Aliases. If you 
deactivate Resolve Aliases, Toast records the aliases as unresolved 
aliases, displaying them in italics.

Toast reports that a file or folder could not be found (result code = -43)
This happens sometimes when you drag and drop groups of files 
onto the Toast main window.

To remove the error, rebuild the desktop by restarting the Macintosh 
while you simultaneously press and hold down the Option and 
Command keys.

You see only the first session on a multisession disc
You recorded more than one HFS/HFS+ session on the disc, but 
your current CD-ROM driver doesn’t support multisession discs.

There are two possible solutions:

� If it’s an Apple CD-ROM, update to Apple CD-ROM driver 
version 5.1x or later. 

� Insert the disc into your CD recorder and read it from there 
using the system extension Toast CD Reader. (Toast CD Reader 
mounts each HFS/HFS+ session as an individual volume.) 
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Audio CD Format
Audio CD is one of the basic formats. For more information about its 
use, see “Recording with Audio CD Format” on page 2-11.

Toast reports that your audio file is the wrong format 
Save AIFF files in 16-bit, 44.1-KHz, Stereo or Mono format. Use Toast 
Audio Extractor to extract and save files.

Your audio file sounds as if it’s mono, not stereo
The sound file was saved in Mono format, and [Mono] appears 
beside its name. Toast converts mono files into stereo with both 
channels containing the identical sound information. 

A disc replicator has a problem with your master CD
Many disc replicators require that the master be recorded in DAO 
Mode, not available in Toast 4 Standard. 

DAO mode is a feature of Toast 4 Deluxe. 

You hear noises between audio tracks

If the source CD sounds OK in an audio CD player, extract a couple 
of tracks, and then use Toast to audition the samples and make sure 
they sound clean. If they do, you can eliminate the source CD as the 
cause of the problem.

Another possible cause may be noise from other devices, chatter 
from your hard drive, your computer environment, or your cables. 
Do what you can to eliminate unnecessary devices, dampen noise in 
your computer space, and make sure your cables are connected 
properly.

Finally, some versions of recorder firmware can cause clicks between 
tracks. Contact the recorder manufacturer to get a firmware update.

Toast reports that your recorder doesn’t support index generation
In TAO Mode, some CD recorders ignore index markers. If your 
recorder supports index markers and you want to preserve 
index-points, you need to record in disc-at-once mode (DAO). 
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Only the first session on a multisession audio CD plays in your CD 
player
Consumer audio CD players are incapable of accessing multiple 
session of an audio CD. Only the first sessions tracks can accessed 
by an audio CD player.

Toast reports buffer underruns (or crashes) while recording an audio 
CD from your CD-ROM drive
The source CD may be scratched or dirty, or the CD-ROM drive may 
be too slow for the recorder. Check the source CD and clean it. 
Change the Write Speed in the Recorder menu. Then try again in 
Simulation Mode. 

Specific extensions are another possible cause of the problem. 

Disable all extensions except Apple CD-ROM, Foreign File Access, 
and ToastSupport extensions. Here are the steps to follow:

1 To bring up the Extensions Manager control panel, press and 
hold down the spacebar as you restart or power up your 
Macintosh. 

2 In the Extensions Manager control panel, uncheck all boxes, 
except for the Apple CD-ROM, Foreign File Access, and 
ToastSupport extensions. 

3 Close the Extensions Manager and allow the system to 
continue powering up. 

With Apple CD-ROM, Foreign File Access, and Toast Support the 
only extensions enabled, open Toast and try your recording session 
again. We recommend that you use Simulation Mode first, to verify 
the problem has been resolved. (For details, see “Using Check Speed 
and Simulation Mode” on page 2-2.)

For more information on buffer underruns, see “Buffer Underruns 
During Recording” on page 5-8.
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DISC Copy Format
DISC Copy is one of the basic formats. For more information about 
its use, see “Recording with DISC Copy Format” on page 2-20.

Your CD-ROM drive can’t read a CD copy of a SCSI hard disk
If you try to copy an MS-DOS formatted hard disk directly, you 
won’t be able to read the CD. 

Mount the hard disk on your Macintosh and record it in Files & 
Folders format (see “Recording with Files & Folders Format” on 
page 2-7) rather than DISC Copy.

Toast reports that it can’t copy a CD directly
You may receive an error message when you use the Check Speed 
feature or as you start the writing process. If you are trying to copy a 
CD containing mode2 form2 (such as video CD, CD-i, CD Extra, or 
photo CDs), it cannot be copied directly. 

General Problems
Occasionally, you may encounter problems not directly related to a 
specific format choice. Here are some suggestions.

Checking the Data Transfer Rate
It is not necessary to use the Check Speed feature every time you 
record, but it can be useful in some circumstances. For more 
information, see “Using Check Speed and Simulation Mode” on 
page 2-2. The following problems may occur when you use Check 
Speed.

Toast reports Error code = 2 
Your Macintosh cannot read the selected data. You may be trying to 
copy a disc containing mode2 form2 or audio sectors. 

To extract audio, you can use Toast Audio Extractor. 
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Toast tells you it doesn’t recognize the SCSI driver
Some drivers on your Macintosh (for example, for background 
application) may cause problems during recording. 

Restart your Macintosh holding down the Shift key to turn off all 
extensions. Or use Extensions Manager to turn off non-essential 
extensions. 

The recorder can’t write a CD-ROM XA track on a CD-ROM
Some recorders can’t mix formats on a disc.

Select the data in Files & Folders format.

Toast can’t allocate the space needed for a temporary hard disk cache
The data you selected contains many small files, and Toast wants to 
save them in a temporary hard disk cache to avoid speed problems 
during recording. The currently selected hard disk doesn’t have 
enough available disk space to save all the required files.

Choose Preferences from the Edit menu and select a hard disk with 
adequate free space.

Write Session isn’t available in the Start Writing Now dialog box
There are several possible causes: 

� You selected more than 625 MB of data to write. 

� There’s not enough free space on the disc to write more 
sessions after the current one.

If there won’t be enough space for another session, Toast disables 
the Write Session option.

To regain the option, insert a blank CD-R. 
5-6



 

Troubleshooting

Toast tells you your recorder can’t write a disc in a particular format
Not all recorders can record all disc formats.

Consult your recorder manufacturer. There might be a firmware 
update for your recorder that enables it to write these formats.

You want to do a test recording without wasting a blank CD
To complete the normal recording process without actually writing 
any data, use Simulation Mode. During simulation, Toast performs 
various checks to verify the integrity of your hardware setup and 
software settings. 

There are two ways to use Simulation Mode:

� Choose Simulation Mode from the Recorder menu

� Click Write CD in the Toast main window. In the Start Writing 
Now dialog box that appears, activate the Simulation Mode 
check box. Then select Write Session or Write Disc for the 
simulation.

For more information, see “Using Check Speed and Simulation 
Mode” on page 2-2.

Toast won’t let you record another session on a CD that’s got only a 
small amount of data recorded on it
When you click Write CD in the Toast main window, the Start 
Writing Now dialog box appears. In that dialog box you have the 
options Write Disc and Write Session. If you select Write Disc, the 
disc is closed when Toast finishes that recording session. For 
multiple sessions, you must select Write Session.

To learn more about a CD inserted in your CD recorder, choose Disc 
Info from the Recorder menu. For details, see “Disc Info” on 
page 3-6.
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Buffer Underruns During Recording
Once Toast begins to record, or “burn,” the data to a CD, it cannot 
stop, or even slow down, until all the selected data has been written 
to the CD. Data must be transferred to the CD recorder at a rate that 
is as fast, or faster, than the recorder Write Speed setting. (To see the 
speed selected, choose Write Speed from the Recorder menu. Or 
click Write CD in the Toast main window, and note the Speed in the 
Start Writing Now dialog box.) If data is not provided to the 
recorder fast enough, the storage buffers within the recorder run out 
of data to write, causing the write process to end. This condition is 
known as a buffer underrun, and when it occurs, the partially 
written CD is unusable.

A faulty hardware setup can reduce the data transfer speed of all 
devices on the SCSI bus and contribute to buffer underrun errors. 
Incorrect termination, poor quality SCSI cables, cable lengths 
exceeding 3 feet, too many devices, or a faulty device have been 
known to cause SCSI bus data corruption resulting in SCSI bus 
failures, or multiple command/data retries.

Check all devices for proper termination. Make sure individual 
external cables do not exceed 3 feet in length and that each cable 
meets the required standard. Be sure not to exceed the maximum 
number of devices allowed on the bus, and make sure each device is 
properly configured. If the recorder is one of several devices 
connected, try removing the other devices and terminating the 
recorder.

After you verify the hardware setup and make any necessary 
changes, record in Simulation Mode to see if the problem has been 
resolved. For more information, see “Using Check Speed and 
Simulation Mode” on page 2-2.
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Error Messages
Some error messages come from Toast, others come from your 
recorder or your operating system. If you get an error that isn’t 
explained in this chapter, please write down the error number or the 
sense code and description before you request technical support. 
The information is a big help in solving your problem.

Another way to record an error message is to take a screen snapshot. 
To do this, press and hold down one of the following key 
combinations:

� Command + Shift + 3 = entire screen

� Command + Shift + 4 = custom size

� Caps Lock + Command + Shift + 4 = a particular window

The snapshot files (Picture 1, Picture 2, and so on) are automatically 
saved on your hard disk. To open a file, double-click it, and then you 
can print it.

Description = BUFFER UNDERRUN
The recorder’s data buffer ran over while writing the CD. The 
recording has been aborted, and the disc is unusable.

Turn off all non-essential extensions. Remove unnecessary devices 
from the bus (SCSI, USB, etc.). Choose a lower Write Speed from the 
Recorder menu. Choose Preferences from the Edit menu and 
increase the RAM Cache. For SCSI, check cables and termination 
and replace them as needed. See also, “Buffer Underruns During 
Recording” on page 5-8.

Description = TRACK FOLLOWING ERROR
The problem is with calibration. The write laser can’t find the last bit 
of data on the disc.

Possible causes:

� The recorder may not be level. 

� The inserted CD-R may be damaged. 

� The recorder’s calibration mechanism is defective.
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Error code = 2 
Your Macintosh cannot read the selected data. You may be trying to 
copy a disc containing mode2 form2 or audio sectors. Toast cannot 
copy such a disc.

Error code = –35
Resolve Aliases is checked (activated), and aliases in the data you 
are copying point to a volume Toast can’t find. 

Mount the missing volume or deactivate Resolve Aliases. If you 
deactivate Resolve Aliases, Toast records the aliases as unresolved 
aliases, displaying them in italics. 

Error code = –50 (while trying to copy audio CDs)
There are two possible causes, one related to recording from a source 
CD, the other related to reading the source CD. 

� Recording—Third-party CD-ROM drivers (for example, FWB 
CD-ROM Toolkit) may cause problems if they are enabled 
when Toast tries to record an audio CD. As an alternative, 
control the CD-ROM with CD-ROM SpeedTools product from 
InTech USA (www.intechusa.com). 

If the source CD is scratched or dirty, do what you can to clean 
it. It is sometimes possible to polish off superficial scratches. 
Also try extracting the audio from the source CD in your 
recorder. (This requires Toast CD Reader.) 

� Reading—The only driver we support for reading from your 
recorder is the Toast CD Reader. 

Result code = -43
Toast cannot find a file or folder you've dragged and dropped on the 
Toast main window. To resolve the problem, rebuild the desktop by 
restarting the Macintosh while you simultaneously press and hold 
down the Option and Command keys.

SCSI error—an unstable SCSI connection
Cables, terminators, or SCSI ports might be damaged.

Check cable connections and termination. In normal disk operations 
your computer system is more tolerant, but recording a CD requires 
5-10



 

Troubleshooting

perfect SCSI connections. For additional information, see “Setting 
Up and Turning On Your CD Recorder” on page 1-4.

Sense Key = HARDWARE ERROR
The recorder may be damaged. 

Sense Key = MEDIUM ERROR
Data on the source disk may be corrupted. If possible, run a repair 
program (such as Disk First Aid) on the disk. 

It is also possible that the brand or batch of CD-Rs you are using is 
not working out. Change brands. There are big differences in quality.
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Glossary of Terms
AIFF

Audio Interchange File Format, created by Apple as a standard 
format for saving sound files of any type.

Apple Extensions

In the ISO 9660 format, Settings panel, there is an option you can 
check called “Use Apple Extensions.” When you use this option, you 
preserve the resource fork in Macintosh files. ISO 9660 format is 
available only with Toast 4 Deluxe.

Audio Sectors

Audio sectors are made up of the sound data you hear plus error 
correction data. 

Audio Tracks

Audio tracks are simply a collection of audio sectors. These tracks 
are playable on standard audio CD players. For the audio CD 
players to be able to recognize and play the tracks, the tracks must 
always be in the first session on the CD.
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Blue Book

The Blue Book specifies the CD Extra standard for interactive CDs. 
Also known as Enhanced CD, a CD Extra disc is a multisession CD 
which contains two sessions. The first session consists of pure audio 
tracks; the second session consists of a data track in a restricted 
format.

If you insert a CD Extra into an audio CD player only the audio 
tracks are visible; the data session cannot be played.

Not all CDs containing an audio session and an additional data 
session are CD Extras. The data tracks must contain special 
information such as MPEG still pictures. Special software is needed 
to create a CD Extra file structure or a QuAC file.

CD

A CD (Compact Disc) consists of up to approximately 333,000 
sectors. 

CD Extra - see Blue Book

CD-i - see Green Book

CD-Recordable (CD-R)

CD recordables are special CDs that can record data by using a 
special laser that “burns” microscopic holes in the recording layer. 
These pits can then be read by standard CD readers. Recordable CDs 
are somewhat more fragile than standard CDs, so care should be 
taken in their storage and handling. The label side is particularly 
delicate.

CD-ROM Tracks

CD-ROM tracks are made up of mode 1 sectors, type 2 (see “About 
CDs” on page 3-10) and are used for many file systems such as 
HFS/HFS+, ISO 9660, and others.

CD-RW

A CD-rewritable disc can be written to, erased, and re-recorded 
many times.
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CD TEXT

CD TEXT is a recent addition to the CD audio specification allowing 
disc and track related information to be added to standard audio 
CDs for playback on suitably equipped CD audio players.

CD TEXT is compatible with the ITTS (Interactive Text Transmission 
System) standard. CD TEXT-equipped players can provide a range 
of display formats. The specification also allows for additional data 
in the future, such as JPEG coded images.

CR/LF Format

CR/LF stands for carriage return/line feed, the end-of-line 
characters used in standard PC text files. On the Macintosh, only the 
carriage return (CR) is used. In UNIX, only the line feed (LF) is used. 

Disc-At-Once (DAO)

Disc-at-once is a method of recording CDs whereby the entire CD is 
recorded in one pass without turning off the laser. DAO is a feature 
of Toast 4 Deluxe.

Enhanced Music CD /CD Extra - see Blue Book

Green Book

The Green Book describes the details of the CD-i format. 

CD-i, developed by Philips, is a computer system able to read CDs 
in the following formats: CD-i, Video CD, and PhotoCD. A disc in 
CD-i format consists of one CD-i track with mode2 sectors, types 4 
and 5. (For details, see “About CDs” on page 3-10.) Unlike other 
CD-ROM XA discs, a CD-i track has no entry in the TOC (table of 
contents).
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HFS/HFS+

Hierarchical File System. HFS/HFS+ is the standard Macintosh file 
system. Because of the Macintosh computer’s ability to use long file 
names and the unique data fork/resource fork structure of 
Macintosh files, HFS is not conformant to the ISO Standard. On a 
CD recorded in HFS/HFS+ format, each session is represented as a 
separate volume on the desktop.

Files & Folders format creates CDs in the HFS format. For more 
information about creating CDs in the HFS+ format, see “Recording 
a CD in HFS+ Format” on page 3-9.

The ability to create HFS+ format is available only with Toast 4 
Deluxe.

Index / Index Point

Every sector contains an index which is a number between 0 and 99. 
Index 0 and 1 have special meanings: 0 indicates a pause sector and 
the beginning of data in a track.

ISO 9660

ISO 9660 format is a standard for cross-platform CD-ROMs. Discs 
created in this format can be read by many different operating 
systems, including Mac, Windows, DOS, UNIX, etc.

Under ISO 9660 the Macintosh does not support long file names, 
custom icons, or saved directory settings (that is, “view by Icon”). 
For this reason, ISO 9660 is not ideal if your CDs are intended only 
for Macintosh users.

ISO 9660 format is available only with Toast 4 Deluxe.

ISRC-Code 

The ISRC-Code holds the “serial number” of each track in a 
standardized format (as prescribed by the Red Book). ISRC codes 
cannot be set in Toast, Adaptec Jam has to be used to define these 
codes. (See also “Red Book” on page 6-7.) 
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Media Catalog Number

The Media Catalog Number (MCN) is a unique identification 
number for the CD (UPC/EAN Bar-Code). It is issued centrally by 
the EAN authority and consists of a series of 13 consecutive digits. 
You can define the MCN only in Adaptec Jam.

Mixed Mode CD

A Mixed Mode CD consists of one data track and several audio 
tracks. Data and audio are written in one session. The data track is 
always placed before the audio tracks on the CD and this order 
cannot be changed.

The Mixed Mode format has generally been superseded by the 
audio/data multisession format, where the first session consists of 
audio tracks and the second session consists of data (CD Extra or 
second session in HFS/HFS+, ISO 9660 XA, Mac/ISO Hybrid XA 
format).

Mixed Mode format is available only with Toast 4 Deluxe. 

MPEG

MPEG is a standardized compression method for audio and video 
data. Because of its very high compression rates, MPEG makes it 
possible to play full screen/full motion video from a CD. MPEG 
tracks consist entirely of mode2 form2 sectors and are mostly found 
on video CDs and CD-i discs.

Multisession

A multisession CD consists of multiple sessions, each recorded at a 
different time. Each of the sessions are linked together in such a way 
that only one logical device appears when the CD is mounted. Not 
all CD-recorders can record this type of CD and not all CD-ROM 
drives can read them.
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Multivolume

A multivolume CD consists of multiple sessions, each recorded at a 
different time. Each of the sessions are completely independent of 
one another so that when the CD is mounted, each session appears 
as an individual logical volume. Not all CD-recorders can record 
this type of CD and not all CD-ROM drives can read them.

Note: HFS/HFS+ CDs can only be multivolume, not 
multisession.

Orange Book

The Orange Book is the name of the standard developed by Sony 
and Philips for recordable CDs (CD-Rs). Part II of the Orange Book 
describes the structure of an empty CD-R and the recording 
procedure on a physical level.

Pause

A data CD recorded in TAO Mode contains 150 sectors (2 seconds) 
of pause and 2 run-out sectors between tracks. 

On a Mixed Mode CD (data + audio) written in TAO Mode, the gap 
equals 377 sectors: 375 of pause and 2 run-out sectors. 

A CD with multiple audio tracks written in TAO Mode has gaps of 
150 sectors pause and 2 run-out sectors. CDs recorded in DAO Mode 
do not have a fixed number of sectors between tracks. 

Q-Codes

Q-Codes contain extra information about sectors such as the ISRC 
code, the MCN, and the indexes. 

QuAC File

In 1995 Apple introduced the QuickTime Audio Containable 
standard for documents that contain information for music CDs as 
well as pictures and optional interactive controls. QuAC files can be 
created with the Apple Interactive Media Toolkit (AIMT). AIMT can 
be obtained on the Web, but is no longer available through Apple 
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Red Book

The Red Book is the original CD-DA (Compact Disc Digital Audio) 
standard developed by Sony and Philips. The Red Book defines the 
format in which an audio CD must be recorded so that an audio CD 
player can play it. It also specifies what a CD player must do to play 
audio CDs correctly. A CD recorded in accordance with the Red 
Book standard can be played in any CD-player.

Run-Out Sectors

Run-out sectors are created because the write laser beam cannot be 
turned off immediately upon termination of data recording. 
Consequently, 2 sectors are allocated to be “wasted” as the laser 
shuts down.

Scrambling

Data on a CD is scrambled (the bits of data are not recorded one 
after another in sequential order; the data is mixed up in a 
predefined pattern.) The recorder scrambles the data while writing 
and the CD player descrambles it when reading. 

Session

A session is a collection of one or more tracks. Each recording 
procedure generates a session that contains all the tracks recorded at 
that time. A CD recorded in multiple recording sessions is known as 
a multisession CD.

TOC

The TOC (table-of-contents) contains a list of the contents of a CD. 
The TOC contains an entry for each session and each track which 
lists the absolute start time of each track (except CD-i tracks which 
have no entry in the TOC). This information is used by CD players 
to access each track, allowing fast random access to tracks and 
supporting features such as shuffle. (The end or length of the track 
or session is not recorded in the TOC.) 
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Track

The track is the smallest logical unit on a CD. A track is a minimum 
of 600 sectors in length, and a CD can contain up to 99 tracks. There 
are three types of tracks: audio tracks, CD-ROM tracks, and 
XA/CD-i tracks. 

In most cases, each track must be preceded by 150 empty sectors. 
However, a CD recorded in DAO Mode requires the 150 sectors only 
before track 1.

Track-At-Once (TAO)

The Track-At-Once Mode records each track of a CD individually 
with 150 empty sectors immediately preceding it. Run-out sectors 
are created at the end of each track. For more information, see 
“Track-At-Once (TAO) Recording” on page 3-9.

Video CD - see White Book

White Book

The White Book describes the data format of a video CD. Video CD 
format is used to record full-motion video or movies on a CD. 
Playing a video CD requires special equipment, including an MPEG 
decoding system.

If you want to write a White Book compatible video CD that can be 
played on video CD and CD-i players, use the Video CD format. A 
Video CD track must always be placed in the first session of a CD.

Video CD format is available only with Toast 4 Deluxe.

XA / CD-i Tracks

These tracks contain only mode2 sectors and are used for ISO 9660 
XA CDs, CD-is, video CDs and photo CDs.

Yellow Book

The Yellow Book is a document that specifies all parameters for 
CD-ROMs. The adherence to these parameters guarantees that the 
CD can be used on all CD-ROM drives. The Yellow Book does not, 
however, specify the data structures.
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See Recorder menu
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